Transverse Phase Space Emittance Diagnostics

B. Walasek-Höhne, Kay Wittenburg, Gero Kube

GSI (Darmstadt) & DESY (Hamburg)
**Accelerator Key Parameters**

- **light source**: spectral brilliance
  - measure for phase space density of photon flux
    \[ B = \frac{\text{Number of photons}}{[\text{sec}][\text{mm}^2][\text{mrad}^2][0.1\% \text{ bandwidth}]} \]
  - user requirement: high brightness
    \[ \rightarrow \text{lot of monochromatic photons on sample} \]
  - connection to machine parameters
    \[ B \propto \frac{N_\gamma}{\sigma_x \sigma_x' \sigma_z \sigma_z'} \propto I \]

- **collider**: luminosity
  - measure for the collider performance
    \[ \dot{N} = \mathcal{Q} \cdot \sigma \]
  - relativistic invariant proportionality factor between cross section \( \sigma \) (property of interaction) and number of interactions per second
  - user requirement: high luminosity
    \[ \rightarrow \text{lot of interactions in reaction channel} \]
  - connection to machine parameters
    \[ \mathcal{Q} = \frac{I_1 \cdot I_2}{\varepsilon} \]
    for two identical beams with emittances \( \varepsilon_x = \varepsilon_z = \varepsilon \)

- **requirements**
  - design of small emittance machine
    \[ \rightarrow \text{proper choice of magnet lattice} \]
  - preserve small emittance
    \[ \rightarrow \text{question of stability} \]
    \[ \rightarrow \text{require active feedback systems / careful design considerations} \]
Transverse Emittance

- projection of phase space volume
  - separate horizontal, vertical and longitudinal plane
- accelerator key parameter
  - defines luminosity / brilliance
- linear forces
  - any particle moves on an ellipse in trace space (x, x')
  - ellipse rotates in magnets and shears along drifts
    → but area is preserved: emittance
- transformation along accelerator
  - knowledge of the magnet structure (beam optics)
    → single particle transformation
    \[
    \begin{pmatrix}
      x \\
      x'
    \end{pmatrix}_f =
    \begin{pmatrix}
      m_{11} & m_{12} \\
      m_{21} & m_{22}
    \end{pmatrix}
    \cdot
    \begin{pmatrix}
      x \\
      x'
    \end{pmatrix}_i
    \]
  - transformation from initial (i) to final (f) location
  → transformation of Courant-Snyder/Twiss parameters
    \[
    \begin{pmatrix}
      \beta \\
      \alpha \\
      \gamma
    \end{pmatrix}_f =
    \begin{pmatrix}
      m_{11}^2 & -2m_{11}m_{12} & m_{12}^2 \\
      -m_{11}m_{21} & 1+m_{12}m_{21} & -m_{12}m_{22} \\
      m_{21}^2 & -2m_{21}m_{22} & m_{22}^2
    \end{pmatrix}
    \cdot
    \begin{pmatrix}
      \beta \\
      \alpha \\
      \gamma
    \end{pmatrix}_i
    \]
Transverse Emittance Ellipse

- propagation along accelerator
  - change of ellipse shape and orientation → area is preserved

\[ \varepsilon = \gamma(s) x(s)^2 + 2\alpha(s) x(s) x'(s) + \beta(s) x'(s)^2 \]

beam envelope: \( \sqrt{\varepsilon\beta(s)} \)

beam waist:
→ minimum in envelope → minimum in \( \beta \) → \( \beta' = 0 \) → \( \alpha = 0 \)

\[ \alpha(s) = -\frac{\beta'(s)}{2} \]
\[ \gamma(s) = \frac{1 + \alpha^2(s)}{\beta(s)} \]
\[ x(s) = \sqrt{\varepsilon\beta(s)} \cdot \cos[\Psi(s) + \Phi] \]
**Emittance and Beam Matrix**

- via Twiss parameters

\[ \varepsilon = \gamma x^2 + 2\alpha x x' + \beta x'^2 \]

- statistical definition

\[ \varepsilon_{\text{rms}} = \sqrt{\langle x^2 \rangle \langle x'^2 \rangle - \langle xx' \rangle^2} \]

**beam matrix**

\[ \Sigma = \begin{pmatrix} \Sigma_{11} & \Sigma_{12} \\ \Sigma_{21} & \Sigma_{22} \end{pmatrix} = \begin{pmatrix} \langle x^2 \rangle & \langle xx' \rangle \\ \langle xx' \rangle & \langle x'^2 \rangle \end{pmatrix} = \varepsilon \begin{pmatrix} \beta & -\alpha \\ -\alpha & \gamma \end{pmatrix} \]

\[ \varepsilon = \sqrt{\det \Sigma} = \sqrt{\Sigma_{11} \cdot \Sigma_{22} - \Sigma_{12}^2} \]

- transformation of beam matrix

\[ \Sigma^1 = M \Sigma^0 M^T \]

\[ M = \begin{pmatrix} m_{11} & m_{12} \\ m_{21} & m_{22} \end{pmatrix} \]

\[ \Sigma^0 = \begin{pmatrix} \sigma_x^2 & 0 \\ 0 & \sigma_y^2 \end{pmatrix} \]


- 2\text{nd} moment of beam distribution \( \rho(x) \)

\[ \langle x^2 \rangle = \frac{\int_{-\infty}^{\infty} dx \ x^2 \cdot \rho(x)}{\int_{-\infty}^{\infty} dx \ \rho(x)} \]

- \( \varepsilon_{\text{rms}} \) is measure of spread in phase space
- root-mean-square (rms) of distribution

\[ \sigma_x = \langle x^2 \rangle^{1/2} \]

- \( \varepsilon_{\text{rms}} \) useful definition for non-linear beams

\[ \rightarrow \] usually restriction to certain range

(c.f. 90% of particles instead of \([-\infty, +\infty]\))

Gero Kube, DESY / MDI
Emittance Measurement: Principle

- **Emittance**: projected area of transverse phase space volume
- **Not directly accessible for beam diagnostics**

\[ \varepsilon = \sqrt{\det \Sigma} = \sqrt{\Sigma_{11} \cdot \Sigma_{22} - \Sigma_{12}^2} \]

- **Measured quantity**
  - **Beam size**: \( \sqrt{\Sigma_{11}} = \sqrt{\langle x^2 \rangle} = \varepsilon \beta \)
  - **Beam divergence**: \( \sqrt{\Sigma_{22}} = \sqrt{\langle x'^2 \rangle} = \varepsilon \gamma \)
  - **Divergence measurements seldom in use**
    -> restriction to profile measurements

- **Measurement schemes**
  - **Beam matrix based measurements**
    -> determination of beam matrix elements:
  - **Mapping of phase space**
    -> restrict to (infinitesimal) element in space coordinate, convert angles \( x' \) in position

Gero Kube, DESY / MDI

Beam Instrumentation CAS, Tuusula (Finland), 2-15 June 2018
Circular Accelerators

- emittance diagnostics in circular accelerators
  - circular accelerator: periodic with circumference $C_0$
    - one-turn transport matrix: $M(s+C_0) = M(s)$
    - Twiss parameters $\alpha(s), \beta(s), \gamma(s)$ uniquely defined at each location in ring
  - measurement at one location in ring sufficient to determine $\varepsilon$
    - measured quantity: beam profile / angular distribution

classification

- imaging
  - beam size

- interference
  - beam size

- projection
  - beam divergence

beam divergence

beam size

image size

interference pattern

angular distribution

---

Gero Kube, DESY / MDI

Beam Instrumentation CAS, Tuusula (Finland), 2-15 June 2018
Beam Matrix based Measurements

- starting point: beam matrix
  \[ \Sigma = \begin{pmatrix} \Sigma_{11} & \Sigma_{12} \\ \Sigma_{21} & \Sigma_{22} \end{pmatrix} = \begin{pmatrix} \langle x^2 \rangle & \langle xx' \rangle \\ \langle xx' \rangle & \langle x'^2 \rangle \end{pmatrix} = \varepsilon \begin{pmatrix} \beta & -\alpha \\ -\alpha & \gamma \end{pmatrix} \]

- emittance determination
  - measurement of 3 matrix elements \( \Sigma_{11}, \Sigma_{12}, \Sigma_{22} \)
  - remember: beam matrix \( \Sigma \) depends on location, i.e. \( \Sigma(s) \)
    \[ \rightarrow \text{determination of matrix elements at same location required} \]

- access to matrix elements
  - profile monitor determines only \( \sigma = \sqrt{\Sigma_{11}} \)
  - other matrix elements can be inferred from beam profiles taken under various transport conditions
    \[ \rightarrow \text{knowledge of transport matrix } M \text{ required} \]
    \[ \Sigma^b = M \cdot \Sigma^a \cdot M^T \]
    \[ M = \begin{pmatrix} m_{11} & m_{12} \\ m_{21} & m_{22} \end{pmatrix} \]

- measurement of at least 3 profiles for 3 matrix elements
  \[ \Sigma^a \]
  \[ \Sigma^b_{11} = m_{11}^2 \cdot \Sigma^a_{11} + 2m_{11}m_{12} \cdot \Sigma^a_{12} + m_{12}^2 \cdot \Sigma^a_{22} \]
  \[ \Sigma^c_{11} = m_{11}^2 \cdot \Sigma^a_{11} + 2m_{11}m_{12} \cdot \Sigma^a_{12} + m_{12}^2 \cdot \Sigma^a_{22} \]
  - measurement: profiles \( \sigma^{a,b,c} = \sqrt{\Sigma^{a,b,c}} \)
  - known: transport optics \( M, \overline{M} \)
  - deduced: matrix elements \( \Sigma^a_{11}, \Sigma^a_{12}, \Sigma^a_{22} \)
    \[ \rightarrow \text{more than 3 profile measurements favourable, data subjected to least-square analysis} \]
Beam Matrix based Measurements

- „quadrupole scan“ method
  - use of variable quadrupole strengths
    - change quadrupole settings and measure beam size in profile monitor located downstream

\[
\begin{bmatrix}
1 & 0 \\
\pm 1/f & 1
\end{bmatrix}
\]

\( M_{\text{quad}} \) (f = 1/k)

\[
\begin{bmatrix}
1 & l \\
0 & 1
\end{bmatrix}
\]

\( M_{\text{drift}} \) (drift space)

\[
\begin{bmatrix}
1 & 0 \\
1/f & 1
\end{bmatrix}
\]

\( M_{\text{quad}} \) (f = 1/k)

\[
\begin{bmatrix}
1 & 0 \\
\pm 1/f & 1
\end{bmatrix}
\]

\( M_{\text{drift}} \) (drift space)

\[
M = M_{\text{drift}} M_{\text{quad}}
\]

\( \Sigma_{ll} \) depends quadratically on quadrupole field strength
Beam Matrix based Measurements

„multi profile monitor“ method

- fixed particle beam optics
  → measure beam sizes using multiple profile monitors at different locations

- example:
  emittance measurement
  setup at FLASH injector (DESY)
  courtesy: K. Honkavaara (DESY)

- task
  beam profile measurement

4 monitor stations in a FODO lattice
By moving the lens one can take pictures from the camera in the focus (not preferred due to limited resolution of the optic system) and on other positions. The distance of the lens to various screen positions can be measured by a simple ruler*. The camera is connected to a Computer where the readout software is installed. The pictures (.jpg) can be saved and can be loaded into a free software called “ImageJ” where a profile of an area can be displayed and the cursor position and the value is displayed (8 bit). The $\sigma$ of the profile have to be found for each screen (camera) position and the emittance have to be calculated.

* Move the lens to simulate different screen positions
## Parameters

### CCD

- **Phytec USB-CAM 051H**

<table>
<thead>
<tr>
<th>Resolution</th>
<th>2592 x 1944 (5 MPix), 2048 x 1536 (3.1 MPix), 1800 x 1200 (2 MPix), 1280 x 960 (1.2 MPix), 1024 x 768 (0.6 MPix), 540 x 480 (VGA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td><strong>USB-CAM-051H</strong></td>
</tr>
<tr>
<td>Color / Monochrom</td>
<td>monochrom</td>
</tr>
<tr>
<td>Sensor Format</td>
<td>1/2,5&quot;</td>
</tr>
<tr>
<td>Image Sensor</td>
<td>Aptina MT9P031, CMOS</td>
</tr>
<tr>
<td>Pixel Size</td>
<td>2.2 μm x 2.2 μm</td>
</tr>
<tr>
<td>Color Format</td>
<td>RGB32, RGGB (Raw)</td>
</tr>
<tr>
<td>Lens Holder</td>
<td>C / CS-Mount</td>
</tr>
<tr>
<td>FPS</td>
<td>6 fps to 52 fps</td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>8 bit</td>
</tr>
<tr>
<td>Shutter</td>
<td>Rolling</td>
</tr>
<tr>
<td>Light Sensitivity</td>
<td>1,4 V/lux-sec</td>
</tr>
<tr>
<td>Interface</td>
<td>USB 2.0 High Speed</td>
</tr>
<tr>
<td>Exposure Time</td>
<td>1/10.000 s to 30 s</td>
</tr>
<tr>
<td>Gain</td>
<td>0 dB to 18 dB</td>
</tr>
<tr>
<td>White Balance</td>
<td>-6 dB to +6 dB</td>
</tr>
<tr>
<td>Power Supply</td>
<td>4,5 V bis 5,5 V DC</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>Circa 250 mA bei 5V</td>
</tr>
</tbody>
</table>

### Screen

- **material:** white paper

### Grid Target

- **spacing:** 1 mm

### Laser

- **Laser:** LaserBoy II

---

### BMI Bayerische Laserboy II Wasserwaage 649 015

**Allgemeine Informationen**

- **Artikelnummer:** ET1117000
- **EAN:** 4007368050049
- **Hersteller:** BMI Bayerische
- **Hersteller-Artnr:** 649 015
- **Hersteller-Typ:** 649 015
- **Verpackungseinheit:** 1 Stück
- **Artikelklasse:** Messlaser

**Technische Informationen**

- **Lange der Signalstrecke:** 30m
- **Laserklasse:**
- **Sichtbare Signalstrecke**
- **Rotierende Signalstrecke**

**BMI Bayerische Laserboy II Wasserwaage 649 015 Länge der Signalstrecke 30m, Laserklasse 2, Sichtbare Signalstrecke,
CCD Readout: Introduction

- Readout program: PHYTEC Vision Demo 2.2
- Histogram of grey values
- CCD control parameters
  - Device → Properties

Check always: Do not saturate (255)
Use mm-grid to calibrate the readout setup. Select ROI (where beam image will appear), plot profile, use cursor and enter measurement into pre-prepared Excel sheet “Laser emittance.xlsx”

All yellow cells will be calculated automatically.

Check: Do not saturate (255)
ImageJ: Introduction

- **Press icon** access to start panel

- **Load image file**
  - File → Open (Shortcut: Ctrl + O)

- **Select ROI**:
  - In start panel: select left button (below “File”), usually already pre-selected
  - Then with left mouse button: draw rectangular ROI

- **Plot horizontal projection**
  - Analyze → Plot Profile (Shortcut: Ctrl + k)

- **Save data**
  - List data points
  - Save data as .csv file (required for profile fitting)
**ImageJ: Introduction**

- **profile fitting** → Analyze → Tools → Curve Fitting…

- **load profile data:**
  - load .csv data file

- **delete bad data:**
  - remove first line in file

- **select fit function:**
  - fit profile data
  - $y = a + (b - a) \cdot e^{-\frac{(x-c)^2}{2d^2}}$
Take profiles at 3 different distances lens-screen. Move lense to simulate 3 positions.

Hint 1: Make the distances equal, set $s_1 = 0$, $s_2 = -s_0$
Hint 2: Avoid position at waist (why?)

\[
\sigma = \begin{pmatrix} \sigma_{11} & \sigma_{12} \\ \sigma_{21} & \sigma_{22} \end{pmatrix} = \begin{pmatrix} \sigma_y^2 & \sigma_{yy} \\ \sigma_{yy} & \sigma_y^2 \end{pmatrix} = \epsilon_{rms} \begin{pmatrix} \beta & -\alpha \\ -\alpha & \gamma \end{pmatrix} = \sigma \text{ matrix}
\]

\[
\sigma_y^2 \text{ measured} = M_1^2 \sigma_{11} + 2M_1 \sigma_{12} M_2 \sigma_{12} + M_2^2 \sigma_{22}
\]

No optical elements $\Rightarrow$ $M = \begin{pmatrix} 1 & s \\ 0 & 1 \end{pmatrix}$

\[
\sigma_y^2(S_1) \text{ measured} = \sigma_{11} + 2s_1 \sigma_{12} + s_1^2 \sigma_{22}
\]

\[
\sigma_y^2(S_0) \text{ measured} = \sigma_{11} + 2s_0 \sigma_{12} + s_0^2 \sigma_{22}
\]

\[
\sigma_y^2(S_2) \text{ measured} = \sigma_{11} + 2s_2 \sigma_{12} + s_2^2 \sigma_{22}
\]

with

\[
\sigma_{11} = \sigma_y^2(0) = \sigma_y^2(S_0)
\]

\[
\sigma_{12} = \frac{\sigma_y^2(+s) - \sigma_y^2(-s)}{4s} = \sigma_y^2(+s)
\]

\[
\sigma_{22} = \frac{\sigma_y^2(+s) - 2 \cdot \sigma_y^2(0) + \sigma_y^2(-s)}{2 \cdot s^2} = \sigma_y^2(-s)
\]

Adjust the aperture so that the image looks quite gaussian at its largest size!

Check: Do not saturate (255)

[Graph showing Gaussian distribution with parameters a, b, c, d calculated]
Take profiles at 3 different distances lens-screen.

Make the distances equal, set $s_1 = 0$, $s_2 = -s_0$

Enter the screen positions $+s$, $0$, $-s$ and the measured $\sigma$ from fits (in pixel) at $+s$, $0$ and $-s$ into the Excel sheet:

The emittance is calculated by the formulas. Since the Laser is not gaussian, vary a little(!) the fitted widths. Note how sensitive the emittance behave. => Need of good resolution and good fits.

Check: Do not saturate (255)